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Quick Reference Guide: Directory Database for the Web 

You must add the levels of the Directory database in order below the Organization symbol . 

Note for the optional Facilities Management module: 

If you purchased the Facilities Management module, you should be aware of the relationship 
between the Directory database and that module. This relationship is provided in Notes 

found in each relevant section. 

ADDING AN ORGANIZATION LEVEL TO THE DIRECTORY DATABASE 

Adding the highest organization level is the first step in creating the Directory database. Adding the 

lower levels (apart from the user level) involves the same steps with the exception being that you 
highlight a different organization symbol. 

The Add Organizational Level screen contains three tabs for adding information for an organization: 

 

There are two routes to adding an organization level: 

 Using the Add menu item in the Edit menu 

 Clicking the  button 

These two methods are slightly different and are explained below. 

Adding an Organizational Level Using the Menu 

1. In the Directory tree highlight a level. 

2. From the Edit menu, select Add to add a level below the selected level. 

3. An Add “Organizational level” dialog box will appear. 

4. Proceed with the General Tab section below. 

Adding an Organization Level Using the Add button 

1. In the Directory tree, highlight a level. 

2. Click the  button to add a level below the selected level. 

3. An Add “Organizational level” dialog box will appear. 

4. Proceed with the General Tab section below. 
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General Tab 

At the General tab, you can specify the following for an organizational level: 

 Name 

 Code 

 Provide information that can appear in a tenant billing report 

 Assign a billing description 

1. In the Name text box, enter the organization level name in this text box. There is a 
maximum of 30 alphanumeric characters. 

2. In the Code text box, enter a unique 20 character alphanumeric code for this level. 

3. From the Language list box, select the language that reports will appear in for everyone in 

the organizational level. 

Note: The Language list box may not appear in your system, and not all reports can be 

printed in other languages. Enter the optional name and address information that will 

appear in a billing report. 

4. Enter the optional name and address information that will appear in a billing report. 

5. Click the Add New button to open an Organizational Billing dialog box. There, select a 
billing description to be assigned to the organizational level. 

6. When finished, click the Save & Close button to save your work and close the dialog box. 

Fixed Charges Tab 

Once a fixed charge has been added to the Fixed Charges Pool, it can be added to a person or an 

entire organizational level. After the fixed charges have been added to a person or to an entire 
organizational level, those charges will be listed in the table in the Fixed Charges tab. 

The Fixed Charges tab is used for: 

 Displaying fixed charges for people in the current organizational level 

 Assigning fixed charges to an entire organizational level 

The Code column displays the code for the charge. 

The Description column displays a description of the fixed charge. 

The Qty. column displays the total number of assigned fixed charges. 

The Amount column displays how much the charge costs per unit. 

To remove a fixed charge, click the  button in its row, and an Expire On? dialog box will appear. 

There, type in an expiration date or click the calendar button to select a date when the fixed charge 
will expire. 
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ASSIGNING A FIXED CHARGE TO AN ENTIRE ORGANIZATIONAL LEVEL 

Once a fixed charge has been added to the Fixed Charges Pool, it can be added to an entire 
department.  

Note: A fixed charge cannot be deleted from the pool while it is assigned to a user. 

To add a charge to an entire department, follow these steps: 

Allocate Fixed Charge to all Department Members: When you click this button a table displaying 

all fixed charges and associated codes will appear. There, perform the following: 

1. In the Quantity cell, specify how many units of the charge to apply to the department. 

2. Next, you may accept the default Active on? date, or enter a new one. 

3. Enter the date in one of these formats: mmddyyyy, mm/dd/yyyy, or mm-dd-yyyy, or click 

the calendar button and select a date. 

4. Click the Apply button to apply the charge, and you will return to the Fixed Charges table.  

5. To add an additional charge, click the Allocate a fixed charge to all Department 
members button, and a new row will appear in the Fixed Charges table. 

Usage Exceptions Tab 

At the Usage Exceptions tab, you can set thresholds for telephone usage for an entire organizational 

level. If a threshold limit is met, that level will appear in the Usage Exceptions summary gate and 
Usage Exceptions report. 

HOW TO SET A THRESHOLD AT THE USAGE EXCEPTIONS TAB 

Follow the steps below to set a threshold at the Usage Exceptions tab: 

1. Select the type of threshold you want to set from the Threshold column. 

2. From the list box in the next column, select the operator for each threshold/value 
combination. Choices are >= (greater than or equal to) and <= (less than or equal to). 

3. In the text boxes in the Value column, enter a value for each threshold you want to set. If 
the organizational level you are setting thresholds for meets one or more thresholds, that 
organizational level is flagged as an exception and will appear in the Usage Exceptions 

summary gate and Usage Exceptions report. 

Note: Be sure to enter the value for the threshold according to the required format detailed 

in the Format column. 

Note on the Usage Exceptions Tab  

When setting the same threshold for a person and for an organizational level, the item that is the 

lowest level on the directory tree will appear in the Usage Exceptions summary gate and report. For 
example, if an exception is set for Total Inbound Duration for an organizational level and for a person 
within that same level, because the person occupies a lower branch in the directory tree, that person's 
record will appear in the summary gate and report. 

 



Quick Reference Guide: Directory Database ISI Telemanagement Solutions, Inc. 

Part Number – 905-011019 4 Infortel Select for the Web Version – 9.0 

ADDING A USER TO THE DIRECTORY DATABASE 

Note for the optional Facilities Management module: 

When a new person is added from a service request in Facilities Management, that person's 

record is marked as such. The Directory Administrator can then access a listing from the 

Directory database and use the listing to complete/edit that person's record. 

Whenever a user is added to the Directory database, that user is considered “active” until their status 

is changed to “inactive.” To add a person, follow these steps: 

To add a person, follow these steps: 

1. At the main Directory Database screen, expand the level you want to add a person to until 

the  symbol appears. Click on the  symbol. 

2. Click the  button, or from the Edit menu, choose Add Person from the sub-menu. With 

either method, the Add Person screen will appear. 

3. The Add Person screen contains five tabs for adding information on a person. 

Move: When you click this button, a screen will appear to let you move the current user to another 
organization level. See the section below for information on the Move feature. 

Delete: This button deletes the current user from the database. See below for more information on 
deleting a user. 

Save: Click this button to save the information while keeping the screen displayed. 

Save & Close: Click this button to save the information and close the screen. 

Close: Click this button to close the screen without saving any information. 

General Tab 

Note for the optional Facilities Management module: 

If you purchased the optional Facilities Management module, creating a warehouse is very 

similar to adding a person. However, when creating a warehouse, you must click the Flag 

This Person as an Inventory Warehouse check box. 

The General tab is used for entering basic information for a user as well as indicating if the user will 

or will not receive automatically generated reports, specifying a Billing Class for the user, and 
assigning the user a security level. 

Last Name: Enter the user's last name in this text box. This is a required field. 

First Name: Enter the user's first name in this text box. This is optional. 

Title: Enter the user's title in this text box. This is optional. 

E-mail: Enter the user's e-mail address in this text box. This is optional. 

Note for the optional Facilities Management module: 

If you purchased the optional Facilities Management module, the email address you enter 

here will appear in Facilities Management for a technician. Any changes made in this text box 
will update Facilities Management as well. Conversely, if an email address for a technician is 

updated in Facilities Management, the Directory database will be updated. 
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Language: Select the language that certain reports will appear in for the current user. 

Note: The Language list box may not appear in your system, and not all reports can be 

printed in other languages.  

Exclude this person from auto-mail: Select this check box if you do not want this user to 

automatically receive reports via e-mail. 

Billing Class: Assign the user a Billing Class (default is Billing Class 1) from this list box. This 

selection will determine which Billing Descriptions are used to price the user's calls. 

Billing Rate per Hour: In this text box, enter the hourly billing rate. If this text box is left blank, a 

message box will appear telling you: 

“The billable time field has no entry. This will prevent this person’s time from being billed.  Do you 

wish to leave this field blank?” 

 If you click Yes, then the current record will be saved without a billing rate and the current 

person’s time will be prevented from being billed. 

 If you click No, the message box will close and enter an hourly billing rate. 

Note: The Billing Rate per Hour text box appears if you purchased the optional 

Professional Services Package (PSP) and if you have Enhanced PSP activated. 

Home Site List Box: Select the site where the user is physically located from the Home Site list box. 

If the number of home sites exceeds the maximum number defined at the Misc. System Options 1 
screen during installation, then a Find Word(s) text box and Word Search button will appear. 
There, perform a search for the data source, and the results will appear in the Home Site list box.  

Find Word(s): Enter your search string in this text box. You don't have to enter an entire word, just 

a fragment. After entering a search string, Click the adjoining Word Search button, and the search 
results will include all values containing your search string. 

For example, if you enter a search string of "at", your results will include the following: cathode, flat 

screen, gateway. 

Word Search Button: Click this button to initiate the search. The results will display in the Home 

Site list box. 

Note: The Home Site Search text box and Word Search button will appear only if the 

number of home sites exceeds the maximum defined at the Misc. System Options 1 screen 

during installation. 

Directory Import Key: The Directory Import Key is used when importing new directory information. 

Additionally, it can be used to assign multiple extensions to the same user, support name changes, 
and lets you automate moves and deletions. (Optional) 

Code: In this text box, enter a unique code that will be used when the user's information is exported 

to a time and billing or accounting system. (Optional) 

Room number: Type a valid room number in this text box. This text box appears only if you 

purchased the optional Hospitality module. 



Quick Reference Guide: Directory Database ISI Telemanagement Solutions, Inc. 

Part Number – 905-011019 6 Infortel Select for the Web Version – 9.0 

Flag this person as an inventory “warehouse”: Click this check box to specify that the current 
record is a warehouse. 

Note for the optional Facilities Management module: 

This check box appears only if you purchased the optional Facilities Management module. 

 When clicked, the following will apply: 

 A warehouse cannot have any objects attached to it 

 A warehouse cannot have any fixed or one time charges attached to it 

 A warehouse can have a billing address assigned to it in the Billing Address tab in order to 

create shipping lists 

 A warehouse can have phone numbers assigned to it at the Other Numbers tab 

 The check box cannot be turned off if there is inventory in the warehouse 

 The warehouse cannot be deleted if there is inventory in the warehouse 

Objects Tab 

With the Objects tab, extensions, authorization codes, and trunk facilities (these types of data are 

referred to as “objects”), are added, maintained, and displayed in a table for each user. 

Note for the optional Facilities Management module: 

If you purchased the optional Facilities Management module, a warehouse cannot have any 

objects attached to it  

EXTENSIONS 

An extension can be the actual extension, a credit card number, or a cell phone number assigned to a 
user. 

If the user has a reporting extension, then that will be displayed instead of the user's raw extension. 

 A reporting extension is an extension that shows up in a report. It could be the actual 
extension, the last four digits of a credit card number, or a portion of a cell phone number. 

 A raw extension is an extension as it comes in from the CDR. 

Note: Once you enter an extension and click the Add New button, you cannot change that 

extension. If you need to change it, you must delete that extension and add a new one. 

Adding an Extension 

Follow these steps to add an extension for a user: 

1. In the Extension column, enter the extension as it appears in the CDR. 

2. Depending on the number of data sources defined during the installation process, one of the 
following will apply for the Data Source column: 

 If the number of data sources is less than the maximum number defined during 
installation, a Data Source list box will be displayed. From this list box, select a data 

source for each object for the current user. 
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 If the number of data sources exceeds the maximum number defined during installation, 
then a Look Up button will appear. Click this button to display a Choose Data Source 
dialog box where you can perform a search for the data source. Note: The default data 

source displayed will be the last one selected from the Choose Data Source dialog box. 

3. From the Type list box, select the type of extension (for example, station or cell phone). 

4. Leave the Expires On? column blank when adding a new user. 

5. Click the Reject Calls check box if you do not want calls made to or from this extension 
stored. 

6. Do not click the Import from File check box unless you will be using the Directory Import 
utility. 

7. If you do not want the user's actual extension to appear in reports, in the Report As column, 
enter a reporting extension for the current user. It could be the actual extension, the last four 

digits of a credit card number, or a portion of a cell phone number. 

 If you need to add another extension for this user, click the Add New button. 

 If the user has a reporting extension, then that will be displayed instead of the user's raw 
extension.  

Deleting an Extension 

To delete an extension, enter an expiration date in the Expires On? text box. The extension will 
become inactive after that date. The nightly purge will delete the extension once there are no more 
calls associated with the extension. 

To delete an extension, perform the following: 

 Click in the Expires on? column to display an interactive calendar where you can indicate 
when the extension will become inactive. 

 -or- 

 Click the Clear button in the row of the extension you want to delete, and the current date is 

entered in the Expires On? text box. 

AUTHORIZATION CODES 

An authorization code is alphanumeric and has a limit of 15 characters. 

Note: Once you enter an auth code and click the Add New button, you cannot change that 

auth code. If you need to change it, you must delete that auth code and add a new one. 

Adding an Authorization Code 

Follow these steps to add an authorization code for a user: 

1. In the Auth Code column, enter the code assigned to this user. 

2. Depending on the number of data sources defined during the installation process, one of the 
following will apply for the Data Source column: 

 If the number of data sources is less than the maximum number defined during 
installation, a Data Source list box will be displayed. From this list box, select a data 
source for each object for the current user. 

 If the number of data sources exceeds the maximum number defined during installation, 

then a Look Up button will appear. Click this button to display a Choose Data Source 
dialog box where you can perform a search for the data source.  
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Note: The default data source displayed will be the last one selected from the 

Choose Data Source dialog box. 

3. Click in the Expires on? column to display an interactive calendar where you can select the 
date when the code will become active or inactive. 

 If you need to add another authorization code for this user, click the Add New button. 

Note: Once a code has been saved, that code and the data source cannot be changed. 

Deleting an Authorization Code 

To delete an authorization code, enter an expiration date in the Expires On? text box. The 

authorization code will become inactive after that date. The nightly purge will delete the authorization 
code once there are no more calls associated with the authorization code. 

To delete an authorization code, perform the following: 

 Click in the Expires on? column to display an interactive calendar where you can indicate 
when the authorization will become inactive. 

-or- 

 Click the Clear button in the row of the authorization code you want to delete, and the 
current date is entered in the Expires On? text box. 

TRUNK FACILITIES 

Assigning a trunk facility to a user allows trunk-to-trunk calls to be assigned to a user. 

Adding a Trunk Facility 

Follow these steps to add a trunk facility for a user: 

1. Depending on the number of data sources defined during the installation process, one of the 

following will apply for the Data Source column: 

 If the number of data sources is less than the maximum number defined during 

installation, a Data Source list box will be displayed. From this list box, select a data 
source for each object for the current user. 

 If the number of data sources exceeds the maximum number defined during installation, 

then a Look Up button will appear. Click this button to display a Choose Data Source 
dialog box where you can perform a search for the data source.  

Note: The default data source displayed will be the last one selected from the 

Choose Data Source dialog box. 

2. In the Facility column, select the facility for this user from the list box. The facilities listed 
are those belong to the Data Source selected from the Data Source column. 

If you need to add another data source/facility combination for this user, click the Add New button. 

Deleting a Trunk Facility 

To delete a facility, click the Clear button in the row of the facility to be removed. 
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Charges Tab 

Note for the optional Facilities Management module: 

A warehouse cannot have any fixed or one-time charges attached to it. 

The Charges tab lets you add one-time or fixed charges or credits for the use of special equipment or 
features to a specific user, or to all users within a department. A credit is expressed as a negative 
number -5.00. Fixed Charges appear in Tenant Billing and Cost Summary reports. 

FIXED CHARGES 

Adding Fixed Charges to a User 

Once a fixed charge has been added to the Fixed Charges Pool, it can be added to a user.  

To add a charge, follow these steps: 

1. Click the Add New button, and a Select Fixed Charges screen displaying all the charges 
and associated codes will appear. 

2. In the Quantity cell, specify how many units of the charge to apply to the person.  

3. Next, you may accept the default Active on? date, or enter a new one. To enter a new date, 

click in the Active on? column to display an interactive calendar where you can select the 
date when the charge will become active. 

4. Click the Apply button to apply the charge, and you will return to the Charges tab. Assign 
an expiration date to each charge by clicking in the Expires on? column to display an 
interactive calendar where you can select when the charge will become inactive. 

5. If you need to add an additional charge, click the Add New button, and a new row will 
appear in the Fixed Charges table. 

6. Click the Save button to save the change. 

Removing Fixed Charges From a User 

To remove fixed charges from a user, perform the following: 

1. At the main Directory screen, expand the organization tree until the department containing 
the user you want to edit is displayed. 

2. Select the department by clicking on the symbol, and the records of all the users in that 
department will appear in the right pane of the main Directory screen. 

3. Click the Edit button next to the user whose record you want to edit. 

4. An Edit screen containing that user's information will appear. This screen is similar to the one 
used for adding a user. 

5. Click the Charges tab at the top of the screen, and at the Fixed Charges table perform the 
following: 

 Click the Edit button located in the first column in the row you want to edit of the Fixed 

Charges table, and the row will turn blue. 

 Click in the Expires on? column to display an interactive calendar where you can select 

the date when the fixed charge will become inactive. 

6. After performing the edit, perform one of the following: 

 Click the Update button in the first column to accept the change. 

 Click the Cancel button in the first column to abandon the changes. 

7. Before leaving the tab, be sure to perform one of the following: 
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 Click the Save button to save the change and perform an edit on another tab. 

 Click Save and Close to save the change and return to the Directory Database screen. 

Adding Fixed Charges to an Entire Department 

Once a fixed charge has been added to the Fixed Charges Pool, it can be added to all the users in a 
department.  

To add a charge to all the users in a department, follow these steps: 

1. At the main Directory Database screen, select the department you want to add equipment 

to by clicking on the  symbol in the right hand pane. 

2. Click the  button, or from the Edit menu select the Edit menu item, and the Edit 

Department screen will appear. 

3. At the bottom of the screen, is a table displaying Fixed Charges information for the selected 

department. 

4. Below the table, click the Allocate a fixed charge to all Department members button and 
a Select Fixed Charges screen displaying all the charges and associated codes will appear. 
There, perform the following: 

 In the Quantity cell, specify how many units of the charge to apply to the department 

 Next, you may accept the default Active on? date, or enter a new one. Enter the date in 

one of these formats:  mmddyyyy, mm/dd/yyyy, or mm-dd-yyyy. 

 Click the Apply button to apply the charge, and you will return to the Edit Department 

screen. Assign an expiration date to each charge in the Expires on? cell. 

5. To add an additional charge, click the Allocate a fixed charge to all Department 
members button, and a new row will appear in the Fixed Charges table. 

6. Click the Save button to save the change. 

ONE TIME CHARGES 

Adding One Time Charges to a User 

One Time charges can be entered manually, or selected from the One Time Charges Pool. 

Entering a Charge Manually 

1. If there is not a blank row in the One Time Charges table, click the Add New button. 

2. In the Code field, enter a code for the charge. There is a limit of 20 alphanumeric characters. 
This is optional. 

3. In the Desc. field, enter a description for the charge. There is a limit of 20 alphanumeric 
characters. This is a required field. 

4. In the Quantity field, specify how many units of the charge to apply to the person. This is a 
required field. 

5. In the Unit Charge field, specify how much the charge costs per item. This is required. The 
Ext. Charge field will automatically fill in with the unit charge multiplied by the quantity. 

6. Enter an optional comment in the Comment field. There is a limit of 15 alphanumeric 
characters. 

7. Click in the Charge Date column to display an interactive calendar where you can select 
when the one time charge takes effect. This is a required field. 

8. If you need to add an additional charge, click the Add New button, and a new row will 
appear in the One Time Charges table. 

Selecting a Charge From The One Time Charges Pool 

1. Click the Add from List button, and a Select One Time Charges screen will appear. 
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2. In the Quantity cell for a charge, specify how many units of the charge to apply to the 

person. 

3. Click in the Active On? column to display an interactive calendar where you can select when 
the one time charge takes effect. This is a required field. 

4. Enter an optional comment in the Comment text box. There is a limit of 15 alphanumeric 
characters. 

5. Click the Apply button to apply the charge, and you will return to the Charges tab. 

Removing One Time Charges From a User 

1. At the main Directory screen, expand the organization tree until the department containing 
the user you want to edit is displayed. 

2. Select the department by clicking on the symbol, and the records of all the users in that 
department will appear in the right pane of the main Directory screen. 

3. Click the Edit button next to the user whose record you want to edit. 

4. An Edit screen containing that user's information will appear. This screen is similar to the one 
used for adding a user. 

5. Click the Charges tab at the top of the screen, and at the One Time Charges table perform 
the following: 

 Click the Edit button located in the first column in the row you want to change of the One 
Time Charges table, and the row will turn blue. 

 In the last column of the One Time Charges table, click the  Delete button. 

6. After performing the edit, perform one of the following: 

 Click the Update button in the first column to accept the change. 

 Click the Cancel button in the first column to abandon the change. 

7. Before leaving the tab, be sure to perform one of the following: 

 Click the Save button to save the change and perform an edit on another tab. 

 Click Save and Close to save the change and return to the Directory Database screen. 

INVENTORY TABLE 

The Inventory table details the inventory assigned to the current person's record. The information in 

this table cannot be edited. 

Note: The Inventory table appears only if the optional Facilities Management module was 

purchased. 

Other Info Tab 

The Other Info tab contains two columns of text boxes. The column on the left is where you can 

store a directory of home, car, fax, pager, DID (direct inward dialing), and other numbers for a 
person.  

Note: The numbers entered at this tab are for reference only and do not appear in any 

reports. 
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The column on the right is where you can add a name and address for this person that will appear in a 
Tenant Billing report.  

Note for the optional Facilities Management module: 

If you purchased the optional Facilities Management module and clicked the Flag This 
Person as an Inventory Warehouse check box located in the General Information section, 

you can have phone numbers assigned at this tab to the warehouse. 

Security Tab 

The Security tab is used to control: 

 Who can enter the system 

 Which components of the system a user can access 

 Which organizational levels a user can access. By default, a user can access only themselves. 

 Which data sources a user can access 

At the top of the screen is a set of buttons and a text box that let an administrator designate an ID for 

a user. In the lower part of the screen are three tabs that let an administrator grant access to various 
system functions as well as organizational levels and data sources. Please refer to the table below for 
more information on these tabs. 

Tab Explanation 

Module Access With this tab, a System Administrator or users with Directory 

Administrator privileges can assign access to system modules. A user 
cannot assign access to a module that they themselves cannot access. 

Note for the optional Facilities Management module: 

Using the Module Access tab, you can designate a user as a 

technician, as well as specify the user's Facilities Management access 
level.  

Organizational Access With this tab, a System Administrator or a user with Directory 
Administrator access privileges can specify the organization levels a 
user can access. The top half of the screen is for performing a search 

and displaying the results, and the bottom half (Security and/or Auto 
Mail Access List) displays the organizational levels and people the user 
you are editing will have access to.  

Data Source Access With this tab System Administrator or users with Directory 
Administrator privileges specify which data sources the user can 
access. 

Summary Gates Access With this tab, a System Administrator or users with Directory 
Administrative privileges assign the summary gates the current user 
can display in the Control Center. 

Note: The Summary Gates tab appears only when the 

Dashboard option is purchased. 
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Usage Exceptions Tab 

At the Usage Exceptions tab, you can set thresholds for telephone usage. If a threshold limit is met, 
that person will appear in the Usage Exceptions summary gate and Usage Exceptions report. 

HOW TO SET A THRESHOLD AT THE USAGE EXCEPTIONS TAB 

Follow the steps below to set a threshold at the Usage Exceptions tab: 

1. Select the type of threshold you want to set from the Threshold column. 

2. From the list box in the next column, select the operator for each threshold/value 

combination. Choices are >= (greater than or equal to) and <= (less than or equal to). 

3. In the text boxes in the Value column, enter a value for each threshold you want to set. If 

the organizational level you are setting thresholds for meets one or more thresholds, that 

organizational level is flagged as an exception and will appear in the Usage Exceptions 
summary gate and Usage Exceptions report. 

Note: Be sure to enter the value for the threshold according to the required format detailed 

in the Format column. 

Note on the Usage Exceptions Tab  

When setting the same threshold for a person and for an organizational level, the item that is the 
lowest level on the directory tree will appear in the Usage Exceptions summary gate and report. For 
example, if an exception is set for Total Inbound Duration for an organizational level and for a person 

within that same level, because the person occupies a lower branch in the directory tree, that person's 
record will appear in the summary gate and report. 
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PEOPLE ADDED THROUGH SERVICE REQUESTS 

Note: This section applies only if you purchased the optional Facilities Management module. 

When a new person is added from a service request in Facilities Management, that person's record is 

marked as such. The Directory Administrator can then access a listing from the Directory database 
and complete/edit that person's record there. 

To use this listing, follow these steps: 

1. From the File menu select People Added Through Service Requests, and the People 

Added Through Service Requests screen will appear. 

2. At this screen, select the home site from the Home Site list box. Using this list box, you can 

narrow the list of people you want displayed by home site. You may choose a single site, or 

all sites. 

Note: If the number of home sites exceeds the maximum number defined at the Misc. 

System Options 1 screen during installation, then a Home Site search text box and 
Word Search button will appear. There, perform a search for the home site, and the 

results will appear in the Home Site list box. 

3. Click the Purge button, and the people currently displayed in the table will not appear the 

next time the listing is run. 

4. If you want to print a list of the people displayed, click the Preview button. The list of people 

will not be purged. 

5. Click the Close button to close the screen without saving any information. 

ADDING A RANGE OF EXTENSIONS 

The Add Extension Range menu item lets you enter the entire range of extensions you need for a 
level. For example, if you need to add 25 people in Sales, you can add extensions 1-25 in one step. 

If this is your initial setup, or if you need to add a range of extensions, follow these steps: 

1. In the Directory database screen, expand the level you want to add a person to until the  

symbol appears. Click on the  symbol. 

2. From the Edit menu, or by right clicking in the screen to display the pop-up menu, select 
Add  Add Extension Range, and the Add Item Range dialog box will appear. 

3. Enter the first extension number in the Start text box. 

4. Enter the last extension number in the End text box. 

5. Assign the entire range of extensions to a billing class with the Billing Class list box. 

Note: If you purchased the optional Hospitality module, the Billing Class list box will 
not appear. Instead, there will be a Billing Description list box. Use this list box to 
assign a billing description to the entire range. 

With the Data Source list box, assign the entire range of extensions to a data source. 

Note: The Find Words text box and Word Search button will appear only if the 
number of home sites exceeds the maximum number defined at the Misc. System 
Options 1 screen during installation. 

6. Click OK, and the extensions will appear in the Directory tree. You can now add data for each 
person. Please refer to the section below for information on adding data for each user. 
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EDITING THE DIRECTORY DATABASE 

Editing an Organization Level 

To edit an organization level, follow these steps: 

1. At the main Directory Database screen, expand the organization tree, and highlight the 

level you want to edit. 

2. Click the  button, or select Edit from the Edit menu. 

3. An Editing “level” screen for the selected level will appear. 

4. Make the changes, and click the Save & Close button to apply the changes, or the Cancel 
button to close the screen without applying the changes. 

Editing a User 

Note for the optional Facilities Management module: 

If you purchased the optional Facilities Management module and if you clicked the Flag This 
Person as an Inventory Warehouse check box located on the General tab, this check 

box cannot be turned off if there is inventory in the warehouse.  

To edit a user, follow these steps: 

1. At the main Directory Database screen, expand the organization tree until the department 
containing the user you want to edit is displayed. 

2. Select the department by clicking on the  symbol, and the records of all the users in that 

department will appear in the right pane of the main Directory Database screen. 

3. Click the Edit button next to the user whose record you want to edit. 

4. An Edit screen containing that user's information will appear. This screen is similar to the one 
used for adding a user. 

5. Click one of the tabs at the top of the screen to move to that section, and perform the edit. 

6. After making the changes, be sure to perform one of the following: 

 Click the Save button to save the change and perform an edit on another tab 

 Click Save and Close to save the change and return to the Directory database screen 

EDITING AT THE GENERAL, OTHER INFO AND SECURITY TABS 

Changing information at the General, Other Info, and Security tabs consist of simply correcting an 
entry in one of the text or list boxes. 

After making the changes, be sure to perform one of the following: 

 Click the Save button to save the change and perform an edit on another tab 

 Click Save and Close to save the change and return to the Directory database screen 
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EDITING AT THE OBJECTS TAB 

Note: Once an extension and data source or auth code and data source have been entered, 

the only way to change them is to delete that extension or auth code and add a new one. To 

delete the extension or auth code, click the Delete button  in the last column of the 
appropriate table. 

Before editing at the Objects tab, follow these steps: 

1. At the main Directory screen, expand the organization tree until the department containing 

the user you want to edit is displayed. 

2. Select the department by clicking on the  symbol, and the records of all the users in that 
department will appear in the right pane of the main Directory screen. 

3. Click the Edit button  next to the user whose record you want to edit. 

4. An Edit screen containing that user's information will appear. This screen is similar to the one 

used for adding a user. 

5. Click the Object tab at the top of the screen, and see below for information on editing an 

Extension, Auth Code, or Trunk Facilities: 

Extension 

Note: Once an extension and facility have been entered, the only way to change them is 

to delete that row and add a new one. To delete the row, click the Delete button  in 

the last column. 

 Click the Edit button located in the first column in the row you want to edit of the 
Extension table, and the row will turn blue. 

 If you need to change the extension and/or data source, perform the following: 

◊ Delete the row by clicking the Delete button  in the last column of the row you 

want to change. 

Note: When deleting an extension, it is not removed from the database until all call 

records associated with the extension have been processed. The nightly purge will delete 
the extension once there are no more call records associated with it. Until that specified 

time, the extension is considered “inactive.” When you click the Delete button, today's 
date will appear in the Expire on? cell for the deleted extension. You may accept this 
date, or enter another one indicating when you want the extension deleted. 

◊ Click the Add New button to insert a new row in the table. 

◊ In the new row, enter the new extension in the Extension text box. 

◊ From the Data Source list box, select a new data source. 

 If you only need to change the other data, continue with the following steps: 

 From the Type drop-down list box, select the type of extension (for example, station or 

cell phone). 

 Click in the Expires on? column to display an interactive calendar where you can select 

the date when the extension will become active or inactive. 

 Click the Reject Calls check box to indicate if you want calls made to or from this 

extension stored. 
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 Click the Import From File check box to prevent an extension from being deleted when 
importing a directory file. 

 If you do not want the user's actual extension to appear in reports, in the Report As 
column, enter a reporting extension for the current user. If the user has a reporting 

extension, then that will be displayed instead of the user's raw extension. 

 After performing the edit, perform one of the following: 

◊ Click the Update button in the first column to accept the changes 

◊ Click the Cancel button in the first column to abandon the changes. 

 Before leaving the tab, be sure to perform one of the following: 

◊ Click the Save button to save the change and perform an edit on another tab 

◊ Click Save and Close to save the change and return to the main Directory database 

screen 

Auth Code 

Note: Once an auth code and facility have been entered, the only way to change them is 

to delete that row and add a new one. To delete the row, click the Delete button  in 

the last column. 

 Click the Edit button located in the first column in the row you want to edit of the Auth 

Code table, and the row will turn blue. 

 If you only need to change the date in the Expires On? text box, click in the Expires 

on? column to display an interactive calendar. There, you can select the date when the 
authorization code will become active or inactive. Proceed to Step 6. 

 If you need to change the other data, continue with the following steps: 

 If you need to change the auth code or data source, click the Delete button  in the row 

of the auth code you want to change. 

Note: When deleting an auth code, it is not removed from the database until all call 

records associated with the auth code have been processed. The nightly purge will delete 
the auth code once there are no more call records associated with it. Until that specified 

time, the auth code is considered “inactive.” When you click the Delete button, today's 
date will appear in the Expire on? cell for the deleted auth code. You may accept this 
date, or enter another one indicating when you want the auth code deleted. 

 Click the Add New button to insert a new row in the table. 

 In the new row, enter the new auth code in the Auth Code text box. 

 From the Data Source list box, select a new data source. 

 Click in the Expires on? column to display an interactive calendar where you can select 
the date when the authorization code will become active or inactive. 

 After performing the edit, perform one of the following: 

◊ Click the Update button in the first column to accept the changes 

◊ Click the Cancel button in the first column to abandon the changes. 
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 Before leaving the tab, be sure to perform one of the following: 

◊ Click the Save button to save the change and perform an edit on another tab 

◊ Click Save and Close to save the change and return to the main Directory database 
screen 

Trunk Facility 

Note: Once a data source and facility have been entered, the only way to change them is 

to delete that row and add a new one. To delete the row, click the Delete button  in 

the last column. 

 Click the Edit button located in the first column in the row you want to edit of the Trunk 

Facility table, and the row will turn blue. 

 Click the Delete button  in the row of the trunk facility you want to change. 

 Click the Add New button to insert a new row in the table. 

 In the new row, select the new data source. 

 From the Facility list box, select the new facility. 

 After performing the edit, perform one of the following: 

◊ Click the Update button in the first column to accept the changes 

◊ Click the Cancel button in the first column to abandon the changes. 

 Before leaving the tab, be sure to perform one of the following: 

◊ Click the Save button to save the change and perform an edit on another tab 

◊ Click Save and Close to save the change and return to the main Directory database 

screen 

EDITING AT THE CHARGES TAB 

Note: Once a fixed charge has been assigned, the only fields that can be changed are 
Quantity and Expires On?. If you need to change any of the other fields, you must delete 
that fixed charge and add a new one. A fixed charge is inactivated by setting an expiration 

date for the charge. 

Before editing at the Charges tab, perform the following: 

1. At the main Directory screen, expand the organization tree until the department containing 
the user you want to edit is displayed. 

2. Select the department by clicking on the  symbol, and the records of all the users in that 
department will appear in the right pane of the main Directory screen. 

3. Click the Edit button  next to the user whose record you want to edit. 

4. An Edit screen containing that user's information will appear. This screen is similar to the one 
used for adding a user. 

5. Click the Charges tab at the top of the screen, and see below for information on editing a 
fixed charge or one time charge: 
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Fixed Charge 

 Click the Edit button located in the first column in the row you want to edit of the Fixed 

Charges table, and the row will turn blue. 

 If you need to change a field other than Quantity or Expires On?, perform the following: 

◊ Click in the Expires on? column to display an interactive calendar where you can 

select the date when the fixed charge will become inactive. 

◊ Click the Add New button to insert a new row in the table. 

◊ In the new row, enter the new fixed charges information. 

 If you only need to change Quantity or Expires On?, continue with the following steps: 

 In the Quantity text box enter the new amount. 

 Click in the Expires on? column to display an interactive calendar where you can select 
the date when the fixed charge will become active or inactive. 

 After performing the edit, perform one of the following: 

◊ Click the Update button in the first column to accept the changes, and the Unit 
Charge and Ext. Charge columns will reflect the change in quantity 

◊ Click the Cancel button in the first column to abandon the changes 

 Before leaving the tab, be sure to perform one of the following: 

◊ Click the Save button to save the change and perform an edit on another tab 

◊ Click Save and Close to save the change and return to the main Directory Database 

screen 

One Time Charge 

 In the Code text box, enter the new code. 

 In the Description text box, enter the new code. 

 In the Quantity text box enter the new amount. 

 In the Unit Charge text box enter the new charge. 

 In the Comment text box enter the new comment. 

 Click in the Charge Date text box to display an interactive calendar where you can select 
the date when the one time charge will become active or inactive. 

 After performing the edit, perform one of the following: 

◊ Click the Update button in the first column to accept the changes, and the Unit 
Charge and Ext. Charge columns will reflect the change in quantity 

◊ Click the Cancel button in the first column to abandon the changes 

 Before leaving the tab, be sure to perform one of the following: 

◊ Click the Save button to save the change and perform an edit on another tab 

◊ Click Save and Close to save the change and return to the main Directory Database 
screen 
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DELETING FROM THE DIRECTORY DATABASE 

Note: Only those with Administrative access can delete organization levels and users. 

Deleting an Organization Level 

An organization level cannot be deleted if there are users below it. All users must be deleted, 
deactivated, and purged before the level can be deleted. 

To delete an organization level, follow these steps: 

1. At the main Directory Database screen, highlight the level to be deleted. 

2. From the Edit menu, select Delete Organization, or click the Delete button . 

Note: All levels subordinate to a deleted level will be deleted! 

Deleting a User 

Notes on the Facilities Management module: 

 Normally, when a person is inactivated, their extension(s) and fixed charge(s) will be 

purged according to the purge parameters defined. With Facilities Management however, if 
a person is inactivated that still has fixed charges assigned to their record, a message will 

appear informing you to contact the inventory manager to have the items returned to the 
warehouse thus removing them from the person's record. 

 If you clicked the Flag This Person as an Inventory Warehouse check box located in 

the General tab, the warehouse cannot be deleted if there is inventory in the warehouse. 

When deleting a user, that user is not removed from the database. A user can only be completely 

removed from the system by inactivating the user, purging all CDR associated with that user, and 
then purging all inactive users with no CDR assigned to them. 

Choosing to delete a user marks them as inactive. When you delete (inactivate) a user, all of their 

objects (extensions, cell phone numbers, etc.) and fixed charges are also inactivated. The user will 
remain in the database until there are no more calls or fixed charge transactions in the database for 
that user. This way, you can include the user in reports until their data is gone. The nightly purge 
deletes all call records and fixed charge transactions older than the date set. The system will then 
remove all of the inactive users who no longer have call record data or fixed charge transactions from 
the Directory database. 

Further, once a user’s status is changed to inactive, calls are no longer assigned to that user. 

To delete a user, follow these steps: 

1. In the left pane of the main Directory Database screen, highlight the level containing the 
user you want to delete. 

2. In the right pane of the Directory Database main screen, select the check box next to the 

user or users you want to delete. 

3. From the Edit menu, select Delete User, or click the Delete User button . 

4. Click OK at the message box. 

5. If you are deleting more than one user, click Yes to delete each selection individually, or click 
Yes to All to delete all your choices at the same time. 
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MOVING A USER 

The Move function lets you move one or more users to a different organization level. To move a user 
or users, follow these steps: 

To move a user or users, follow these steps: 

1. At the main Directory Database screen, expand the organization tree until the  symbol 
containing the user(s) you want to move is displayed. 

2. Click the  symbol, and the users in that level will appear in the right pane of the main 
Directory Database screen. 

3. Click the check box next to each user you want to move. 

4. Click the  button, or select Move Users from the Edit menu. A Move screen will appear. 

This screen is used to specify where you want the user(s) moved. 

5. At the top of the Move screen is a Move Selected Users to: list box and text box. These are 
used to search for the organization level you want to move the user(s) to. 

6. With the list box, specify if you want to search by organization level name or code. 

7. In the text box, type the organization level name or code. 

8. Click the Search button, and your results will be displayed in a table. The results will display 

the lowest organization levels because this is where the users' records are located. 

9. Next to each search result displayed in the table, a Move button will appear. Click the Move 

button that is next to the organization level you want the user(s) moved to. 

Note: Once a user is moved, they become inactive in their old location and active in their 

new location. 
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SEARCHING THE DIRECTORY DATABASE 

The Search function is used to quickly find a user or organizational level. You can search by data 
source, user's first or last name, organization name, organization code, title, extension, authorization 
code, fixed/one time charge code, or any combination of these. 

Note: It is important to remember that all of the search specifications entered in the text 
boxes are cumulative. This means that the more search criteria you specify, the more 

specific the search will become. 

The search function is accessed from the Edit menu, or by clicking the  button. After selecting it, a 
Search screen will appear. 

Note: Those with View access cannot search on authorization code, title, or charge codes. 

To search the Directory database, follow these steps: 

1. Using the filter grid at the Search screen, define the search criteria for any or all of the field 
names. When a row is double clicked, a dialog box appears that lets you define an operator 
and search criteria specific to the field name in that row. 

Note: It is important to remember that all of the search criteria specified are cumulative. 
This means that the more search criteria you specify, the more specific the search will 

become. 

2. Using the Sort Order list boxes, specify how you want the results sorted by selecting a field 
name from each list box. The defaults are Organizational Name for 1st Sort, Last Name 
for 2nd Sort and none for 3rd Sort. 

3. Click the Find button, and your results will be displayed in the Search Results table. By 

default, the results are sorted by user name within organization name. You can change the 
sort order by using the Sort Order list boxes, and clicking the Search button again. 

4. Click on a name in the Name column of the Search Results table, and except for those with 
only View access, an Edit screen containing that user's information will appear. 

5. For users with View access, they are taken to the main Directory Database screen with that 
user’s department selected and the list of the users in that department displayed. 

Note: Exceptions based on security level are listed below: 

 If you are searching for a user, after clicking t a name in the Name column of the Search 

Results table, an Edit screen will display for that user. Only those with Administrator and 
User privileges are able to access this screen.  

Note: If an object or person has been inactivated, the word “inactive” will appear next to 

that object or person in the Object column of the Search Results table. 

 For those with View access, the main Directory Database screen will display the expanded 

organization level to which the user searched for is located in, but not the user's Edit screen. 
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OPTION MENU UTILITIES 

Filter Tree View 

The Filter Tree View menu item lets you display all extensions, active extensions, or inactive 

extensions for a specific home site or all home sites. In addition, you can opt to have organization 
levels with no people assigned to them to not be displayed in the organization tree. 

Note: A caption indicating that one or more filter is turned on will appear next to the button 

bar on the Directory Database screen. 

To use this menu item, follow these steps: 

6. From the Options menu, select Filter Tree View, and a Select Filter screen will appear. 

7. From the Extensions/Auth. Codes list box, select which type of extension (active, inactive, 

or all) to display in the organization tree. 

8. From the Home Site list box, select a home site (or all home sites) to display in the 

organization tree. If the number of data sources exceeds the maximum number defined at 
the Misc. System Options 1 screen during installation, then a Find Word(s) text box and 
Word Search button will appear. There, perform a search for the data source, and the 
results will appear in the Home Site list box. Enter your search string in the Find Word(s) 
text box. You don't have to enter an entire word, just a fragment. After entering a search 

string, click the Word Search button, and the search results will include all values containing 
your search string. 

For example, if you enter a search string of "at", your results will include the following: 

cathode, flat screen, gateway. 

Note: The Home Site Search text box and Word Search button will appear only if the 

number of home sites exceeds the maximum number defined at the Misc. System 

Options 1 screen during installation. 

9. If you want to have organization levels with no people assigned to them to not be displayed 
in the organization tree, select the check box. 

10. Click the Reload button to have your selections take effect, or click Cancel to close the 
Select Filter screen. 

11. If you click Reload, the choices selected will be saved for the user that made them. 

Note: The two list boxes can be used in combination with each other. For example, you can 

choose to only have inactive extensions from a specified home site be displayed in the 
organization tree. 

Displaying Active and Inactive Persons 

To display persons with active, inactive, or all extensions in the main Directory Database screen, 

follow these steps: 

1. From the main Directory Database screen, select the Options menu. 

2. Select the Filter Tree View menu item. 

3. At the Select Filter dialog box, select how to filter the directory from the list boxes. 

 From the Extensions list box, select All to display users with both active and inactive 

extensions, Active to display people with just active extensions, or Inactive to display 
people with inactive extensions. 

 From the Site list box, select All to display all sites, or select a specific site. 

4. Click the Reload button. 
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PURGE INACTIVE OBJECTS 

Clicking on the Purge Inactive Objects menu item opens a screen that lets you delete all inactive 

users, objects (except one time charges), and fixed charges. To purge inactive objects, follow these 
steps: 

1. From the Option menu, select Purge Inactive Objects. 

2. A screen appears that lets you specify which objects to purge. 

3. Click the OK button, and those objects will be removed from the Directory database. 

Note: This function is available only for those with Administrator level access.  

UNDEFINED EXTENSIONS 

Adding an Undefined Extension 

When the call accounting software encounters an undefined extension, it will: 

1. Create a person to be assigned to that extension. 

2. Assign a last name of “Undefined” to the newly created person.  

3. Assign a first name of “Extension XXXX” (where XXXX is the extension number) to the newly 

created person. 

4. Add the person to the “Undefined” department. 

5. Assign the default billing class to the new person. 

 For the purpose of running the Undefined Extension report in the Directory, these are still 

considered unassigned calls. 

 Also, for the purpose of running Call Accounting Reports, these calls are also considered 

unassigned. 

Assigning Undefined Extensions to the Correct Departments 

A person created by this process can be moved to any other department. The following will apply: 

 When the person is moved, do not de-activate them in the “Undefined” department. 

 Treat the person as if it always existed in the department to which it was moved. This way 

reports show the calls as belonging to the correct departments. 

 As with any other record, you may edit the first and last names. 

 If you assign an extension that already belongs to another person, you must deactivate the 

old person and then add the extension to the new person. 
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